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Roast Architect

Welcome to Roast Architect

gLORING

The Smarter Way to Roast

Welcome to Roast Architect by Loring Smart Roast! This powerful tool is designed to help
Loring Roaster users to precisely craft their roasts with ease and accuracy. Roast Architect
allows you to create, analyze, and perfect your Profiles, ensuring consistent and exceptional
results every time. Whether you're a seasoned professional or just starting out, Roast Architect
is your ultimate companion in achieving the perfect roast.
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Start Designing your Roasts

This process will show you how to design a Profile, and upload the file to your Roaster.

3/62



EXAMPLE MEDIUM ROAST  x
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Communications

Roast Architect exclusively supports Ethernet communications for all v2 Loring Roaster
systems, excluding early serial numbered systems. To utilize some of the automated features, a
Windows computer or laptop connected to the LAN is required. For proper communication,
the computers or laptops must be on the same sub-net as the connected Roasters. Each IP
address must be unique for the system to function correctly. The Beijer HMI screen and the PLC
are assigned specific IP addresses for each Roaster installation.
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User License

Roast Architect requires a license to activate and operate.

License Activation Options

Your software offers two types of license activation methods: a Limited Time Trial
License and a Purchased License.

Limited Time Trial License

The Trial License allows users to evaluate the software for a limited period before making a
purchase. To activate a trial license:

1. Click the "Request Trial License" button on the License Activation screen.

2. The system will automatically generate and apply a temporary license key.

Once activated, the software will be fully functional for the duration of the trial period.
Note: Trial licenses are typically limited to one per user or device and require an internet
connection for activation.

Purchased License

Users who have purchased a license can activate the full version of the software using their
unique license key. To activate a purchased license:

1. Enter your License Key in the designated input field.

2. Click the "Activate" button.

Upon successful validation, the software will unlock all features for the duration specified by
the license terms.

Tip: Ensure you have a stable internet connection during activation, the license requires online

verification.

Application Operation with License Authentication

In order to authenticate the user license, Roast Architect must be able to connect to the license

server via the intranet. To allow flexibility in the use of the software, once authenticated the
license will remain active offline for a period of time. To check the time remaining before
Roast Architect must re-authenticate with the license server check theLicense Management
page for the Validity with Grace Period time period.

Validity With Grace Period

Grace Period



File Types

Roast Architect can recognize different file types that are associated with Loring
S-Series Roasters. These are listed below.

v1 Support

Roast Architect only supports the viewing and conversion of v1 files into compatible v2 file
formats. It does not allow for the editing and saving of these file types.

v1 File Types

v1 Baseline File (*.csv) - Contains a v1 Roaster baseline.

v1 Burner Recipe File (*.csv) - Contains a v1 Burner Recipe and usually a baseline**.

v1 Profile (Return Air) Recipe File (*.csv) - Contains a v1 Profile curve and a baseline curve**.
v1 Email RST_DATA file (*.csv) - The emailed report log sent by the T100 based v1 Roaster.
v1 Products Files (*.csv) - The bean product names file used by a T100 based v1 Roaster.

v1 Configuration Files (*.csv) - The configuration file saved by a v1 Roaster.

v2 File Types

v2 Baseline File (*.Ircp) - Contains a v2 Roaster baseline.

v2 Burner Recipe File (*.Ircp) - Contains a v2 Burner Recipe.

v2 Profile (Bean Temperature) Recipe File (*.Ircp) - Contains a v2 Profile curve

v2 Email RST_DATA file (*.csv) - The emailed report log sent by the iX based v2 Roaster.
v2 Products Files (*.Iprd) - The bean product names file used by a iX based v2 Roaster.
v2 Configuration Files (*.Icfg) - The configuration files saved by a v2 Roaster.

v2 Configuration Patch Files (*.Icfp) - A configuration patch file used to merge with a v2
Configuration File.

PLC Binary Image *.DLI - Used in updating the Loring Roaster PLC program.

LZIP - Loring Roaster Backup - An zip file that contains an backup of an attached v2 Roaster
configuration files, Products Files, and Roast Profile / recipe files.

v1 File Conversion

Roast Architect will open the following v1 based file types and allow them to be saved as a
converted v2 equivalent. The list of allowable conversions is listed below.

v1 Baseline File (*.csv) -> v2 Baseline File (*.Ircp)

v1 Burner Recipe File (*.csv) -> v2 Burner Recipe File (*.Ircp) **

v1 Profile Recipe File (*.csv) -> v2 Roast Profile File (*.Ircp) **

v1 Products File (*.csv) -> v2 Products File (*.Irpd)

v1 Configuration File (*.csv) -> v2 Configuration Patch File (*.Icfp)

v1 Email RST_DATA file -> v2 Baseline or Profile File (*.Ircp)

** There are some v1 formats that do not have an associated baseline inside their files. The
conversion process to v2 based files relies on the baseline curve to be present. If the curve is
not located in the file, Roast Architect will attempt to notify you that it is not there. The rest of
the Profile information will be converted with a generated sample roast curve for the baseline
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or Profile data.

PDF Files: a
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End User License Agreement and Warranty

Loring Roast Architect™ with Roast Reporter™ Software End User License Agreement

This End-User License Agreement (EULA) is a legal agreement between you (either an
individual or a single entity) and the mentioned author (Loring Smart Roast) of this Software
for the Roast Architect™ with Roast Reporter™ identified above, which includes computer
software and may include associated media, printed materials, and “online” or electronic
documentation ("ROAST ARCHITECT™ with ROAST REPORTER™ “). By installing, copying, or
otherwise using the ROAST ARCHITECT™ with ROAST REPORTER™ , you agree to be bounded
by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or use
the ROAST ARCHITECT™ with ROAST REPORTER™ software .

ROAST ARCHITECT™ LICENSE

Loring Roast Architect™ software is being distributed for personal, commercial use, non-profit
organization, or educational purpose. It may be included with CD-ROM/DVD-ROM
distributions. You are NOT allowed to make a charge for distributing this Software (either for
profit or merely to recover your media and distribution costs) whether as a stand-alone
product, or as part of a compilation or anthology, nor to use it for supporting your business or
customers. It may NOT be distributed freely on any website or through any other distribution
mechanism.

GRANT OF LICENSE

This EULA grants you the following rights: Installation and Use. You may install and use an
unlimited number of copies of the ROAST ARCHITECT™ with ROAST REPORTER™ software.

Reproduction and Distribution

You may reproduce and distribute an unlimited number of copies of the ROAST ARCHITECT™
with ROAST REPORTER™ software ; provided that each copy shall be a true and complete
copy, including all copyright and trademark notices, and shall be accompanied by a copy of
this EULA.

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

Limitations on Reverse Engineering

De-compilation, Disassembly and change (add, delete or modify) any of the associated
resources in the compiled software assembly is strictly prohibited. You may not reverse
engineer, decompile, or disassemble the ROAST ARCHITECT™ with ROAST REPORTER™
software.

Update and Maintenance
Loring Roast Architect™ with Roast Reporter™ software updates are FREE of charge.

Separation of Components
The ROAST ARCHITECT™ with ROAST REPORTER™ are licensed as a single product. Its
component parts may not be separated for use on more than one computer.

Software Transfer

You may permanently transfer all of your rights under this EULA, provided the recipient agrees



to the terms of this EULA.

Termination

Without prejudice to any other rights, the Author of this Software may terminate this EULA if
you fail to comply with the terms and conditions of this EULA. In such event, you must destroy
all copies of the ROAST ARCHITECT™ with ROAST REPORTER™ software and all of its
component parts.

LIMITED WARRANTY

NO WARRANTIES

The Author of this Software expressly disclaims any warranty for the ROAST ARCHITECT™ with
ROAST REPORTER™ software. The ROAST ARCHITECT™ with ROAST REPORTER™ software
and any related documentation is provided “as is” without warranty of any kind, either express
or implied, including, without limitation, the implied warranties or merchantability, fitness for
a particular purpose, or non-infringement. The entire risk arising out of use or performance of
the ROAST ARCHITECT™ with ROAST REPORTER™ software remains with you.

NO LIABILITY FOR DAMAGES

In no event shall the author of this Software be liable for any special, consequential, incidental
or indirect damages whatsoever (including, without limitation, damages for loss of business
profits, business interruption, loss of business information, or any other pecuniary loss) arising
out of the use of or inability to use this product, even if the Author of this Software is aware of
the possibility of such damages and known defects.



Copyright

All title and copyrights in and to the ROAST ARCHITECT™ with ROAST REPORTER™ software
(including but not limited to any images, photographs, clipart, libraries, and examples
incorporated into the ROAST ARCHITECT™ with ROAST REPORTER™ software ), the
accompanying printed materials, and any copies of the ROAST ARCHITECT™ with ROAST
REPORTER™ software are owned by the author of this Software. The ROAST ARCHITECT™
with ROAST REPORTER™ software is protected by copyright laws and international treaty
provisions. Therefore, you must treat the ROAST ARCHITECT™ with ROAST REPORTER™
software like any other copyrighted material. The licensed users or licensed company can use
all functions, example, templates, clipart, libraries and symbols in the ROAST ARCHITECT™
with ROAST REPORTER™ software to create new diagrams and distribute the diagrams.



Trademarks

This publication may contain references to products produced and/or offered by other
companies. The product and company names may be Trademarks (™) or Registered
Trademarks ( ® ) and are the sole property of their respective owners. Loring Smart Roast
disclaims any proprietary interest in the marks and names of others. Microsoft® and its
products are registered trademarks. Windows® is a registered Trademark of Microsoft
Corporation. Automation Direct® and its products are are registered trademarks.NetEdit3 and
DMLoader are programs that are products of Automation Direct.
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Roast Architect User Interface
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Editing View of the Roast Architect user interface

1. Edit View

e View and Edit Roast Architect files

e Tab Docking (Click + Drag) to snap editors to window
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Undocking, and Docking, a File tab

e Docking Hints to Auto Dock and Resize Windows. Hovering over a Docking Hint and
releasing the Mouse button will automatically snap and resize the tab in the program
window.

Tab Docking Hints

2. Navigator

Search for, and Connect to, Loring Roasters
Upload/Download Roast Architect Files to a Loring Roaster
FTP access to Loring Roaster Files via File Explorer

w

. File menu

Recent Files

Manage Profiles: create new, open existing
Manage Products: create new, open existing
Access the application options

Account Details

Access to help files

Exit the application

4. Home Menu
Edit Roast Architect Files

5. Quick access tool-bar

Access to frequently used actions such as "Save", "Undo", and "Redo"

6. Ribbon tool-bar

e Contains all command buttons available for editing within Roast Architect
The Ribbon can be minimized by right clicking and selecting Minimize the Ribbon. To
maximize the Ribbon, click Home, right click on the Ribbon, and click Minimize the
Ribbon again to deselect it.



I}‘ Minirmize the Ribban

The Ribbon Bar content will change according to the currently focused file type and Edit
mode.

o Roast Profile

o Burner Recipe

o Products File

7. Tab Bar

e Select and organize open Roast Architect files

e Undock/Dock files from application window (Click + Drag)
e Selecting a tab will display its associated content for editing

8. Docking Functions

Additional tab docking functions
Group and distribute windows

Float

E Mew Horizontal Tab Group
m Mew Vertical Tab Group

Close All Documents

Reset Window Layout
« 1RST_LOG.csw

2 Products File

3 NewRecipe.rcp

4 Recipe File

Windows...
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"File" - Backstage Menu

The File Menu is the backstage and starting view of Roast Architect. From the backstage you
are able to open Roast Architect files, adjust the program settings, access user account
settings, or access this help guide. The Back Arrow Button will take you back to the Home
screen.

©

Roast Architect

D Mew

- \ LORING

g8 s The Smarter Way to Roast

loring.com
Copyright 2014-2025 Loring Smart Roast, Inc.
All rights reserved.

View of the Roast Architect Backstage File menu.

File Menu

Roast Architect's primary function is to open, create, and edit Profiles and Products files for
Loring Roasters.

Recent Files

1. Select Roast Architect from the File Menu
2. Select a recently opened file to open the file. Profiles will open in the Profile Review
Screen, with editing disabled
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D New & ROAST1.Ircp

r' Open & ROASTZ.Ircp

Settings
Zl@:; . . Clear Recent Files

View of the Roast Architect Recent File menu.

Creating a New Profile

One of Roast Architect's primary functions is to create Profiles. See the Quick Start Guide to
Create a New Profile

Creating a New Products File

Products files are lists that will populate the Product field on the Roaster. The Product
specified at the start of a roast will display on the Roaster screen during the roast, and be
included in the Post-Roast Notes.

See the Quick Start Guide to Create a New Products File

Open a File

Roast Architect can also open and edit existing files from the local computer.
See the Quick Start Guide to Open a Local File

Roast Architect Settings

Use the Roast Architect Settings to set preferences and control some of its features. These
Settings only effect Roast Architect's operation and do not impact any Roasters on the
network.

From the File Menu, select Settings
Select Theme to switch between Light Mode and Dark Mode

3. Select Mass Units to designate the mass units for all Roast Architect reports and editors.
The choices are Ibs. and kg., with Ibs. as the default

17762
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4. Select Temperature Units to designate the temperature units for all Roast Architect
reports and editors. The choices are Fahrenheit and Centigrade, with degrees Fahrenheit as
the default

©

Roast Architect @ Theme Light Mode =
D New ass Units Dark Mode

o .
r— SR F Temperature Units

i@g Settings

Account Page and License Management

The Account screen allows for the activation of Roast Architect via a Trial License, or via
entering the Key for a purchased Roast Architect license. When activated, this screen will show
additional information regarding the status of the license.

Click Request Trial License to activate a temporary trial license for Roast Architect.

To activate a purchased Roast Architect license, enter the License Key and click Activate.
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©

Roast Architect Activate License Trial License

Key
Y vew

_ Activate
' Open

@ Settings

Request Trial License

Product Mame Roast Architect

Status  None

_a Account

Help

About

[ ] et

Help

The Help Menu contains access to this help guide.

About
The About page shows additional details about Roast Architect.

Exit

Closes Roast Architect.
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"Home" - Profile View

Roast Architect

The Home menu allows for the review and editing of Roast Architect files.
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The Roast Architect Home menu showing a Roast Profile Review

H

. Save, Save As

N

. Quick access tool-bar

3. Ribbon Bar

Save the currently focused Roast Architect file
Save as creates a copy of the open Roast Architect file with a new name

Access to frequently used actions such as "Save project”, "Undo", and "Redo"

The Ribbon Bar contains the controls to open, save, and edit Roast Architect files. The editing
controls will change in accordance with the currently focused Roast Architect file. For more
details on the Ribbon Bar, see Editing Tools

4. File Tab Bar

e Select and organize open files
[ ]

o

5. Docking Functions

®

Additional file tab docking functions

Undock/Dock files from application window
Selecting a file will display its associated content for editing
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e Group and distribute file windows
Float

= Mew Horizontal Tab Group
[T Mew Vertical Tab Group
Close All Documents
Reset Window Layout
« 1RST_LOG.csw
2 Products File
3 MewRecipe.rcp
4 Recipe File

Windows...

6. Navigator Panel

e Search for, and connect to, Loring Roasters on the network
e Upload, download, and otherwise interact with Roast Architect Files on a Loring Roaster
e FTP (File Manager) access to Loring Roaster Files

For more details, see Navigator Panel
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Quick Start Guides

To get started quickly, follow the instructions in the following links:

Create a New Profile - Create a new Roast Profile or Burner Recipe
Create a New Products File

Open a Local File - Open a Profile that is stored on the local computer, edit it, and save it back
to the local computer

Modify an Existing File on a Roaster - Open a file that is stored remotely on a Loring Roaster
Upload File to a Roaster - Upload a local file to a Loring Roaster

Open Roaster in File Explorer - Open the FTP connection to a Loring Roaster, accessing all
Profile Files on the Roaster via File Explorer
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Create a New Profile

This quick guide will describe how to create a new Profile for a Loring Roaster.

©

— r—
Roast Architect M Recipe M Light Roast
—
D Mew E Products A/ Medium Roast
—
' Cpen /V Dark Roast

@ Settings

The New Profile menu

From the File menu, select New

Select Recipe, then choose from the templates: Light Roast, Medium Roast, Dark Roast
The template loads as a Roast Profile

Edit the Profile using the Editing Tools

In the Editor view Tool Ribbon, select Save As to save the new Profile to your computer

a s wnN e

To upload this Profile onto a Loring Roaster, see Upload File to a Roaster
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Create a New Products File

This quick guide will describe how to create a new Products File for a Loring Roaster.

1. From the File Menu, select New and then Products
Select Products File
The Products Editing Screen will be shown, and the file will be auto-populated with an
example list

4. Edit the Products File as desired using the Editing Tools

©

i .
Roast Architect A/ Redpe E Products File

E Products
MNew

ri Open

5633 Settings

The New Products File Menu

To upload the file onto a Loring Roaster, see Upload File to a Roaster
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Open a Local File

This quick guide will describe how to open an existing file from the local computer.

©

Roast Architect h &AL

D i Jay Open Producs File

ri Open

2@3 Settings

From the File menu, select Open

Select Open Recipe File or Open Products File

Navigate to the desired file and click Open, or double click the file

Opening a Profile will show the Profile in a view-only mode. The Profile and its attributes
cannot be edited in this mode. If desired, enable Editing from the Ribbon Toolbar

powbdPE

5. Make desired modifications to the file using the Editing Tools

Modify an Existing File on a Roaster

This quick guide will describe how to open an existing Profile or Products File from a Loring
Roaster, edit the file, and save the modified file directly onto the Roaster.

Open the File

1. The Loring Roaster must be connected to Roast Architect. For direction, see Navigator
Panel

Use the Navigator panel to locate the Loring Roaster

Expand the drop-down of the Loring Roaster in the Navigator Panel

Expand the FILES tree and find the file

Double click the file, or right click and select Open

The File will be highlighted blue, indicating that it is open in Roast Architect. The Quick
Access Bar will display the file name preceded by Remote File, indicating you are editing
the file on the Roaster

I
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Opened Remote Files

Edit a Remote Profile
1. Enable Editing with the Ribbon Toolbar

2. Make any modifications to the Profile using the Editing Tools.

Save the File

2 e

Save Save As

e When working with a file opened directly from a Loring Roaster, the Save ribbon bar
function will save the changes to the Roaster's file directly, overriding the file that is on the
Roaster.

e Save As will open the File Explorer to save a new copy on the local computer. To then
upload the file to a Roaster, see Upload a File to a Roaster

A Profile will be saved with the file type that corresponds to the Edit mode toggled at the

time of saving (either Roast Profile or Burner Recipe) and this file type may influence its file
location when uploaded to a Roaster.
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Upload File to a Roaster

This Quick Guide will describe how to upload a Roast Architect File to a Roaster.

Note that if two files with the same name are uploaded to the Roaster, the upload will
override the existing file.

Note also that the Roaster will only recognize Products Files named RoasterProducts.
Therefore, only one Products file can be used on the Roaster at one time. Products files with
other names will not open or populate the drop-down menus on the Roaster screen.

Use the Navigator panel to locate the Loring Roaster connected on a local network
Expand the FILES tree

Right click on the folder to which you wish to upload the file

Click Upload

In File Explorer, select the Roast Architect File to upload to this location

a s wNh e



Open Roaster in File Explorer

This quick guide describes how to access the files on a Loring Roaster directly from Windows
File Explorer. This method can be useful for archiving multiple Roast Architect files from a
Loring Roaster.

Use the Navigator panel to locate the Loring Roaster connected on a local network
Expand the FILES tree

Right click on a folder or Roast Architect File in the tree

Click Explore. This will open the Roaster folder location in File Explorer, via a File Transfer
Protocol (FTP) connection

5. From there, files can be added or removed from a Loring Roaster

powbdPE



Editing Tools

Use the Editing Tools to make adjustments to Profiles and Products Files.

Editing Profiles

The Editing Tools appear differently according to which Edit mode you are using- Roast
Profile or Burner Recipe. The Profile will be saved with the file type that corresponds to the
Edit mode toggled at the time of saving (either Roast Profile or Burner Recipe) and this file
type may influence its file location when uploaded to a Roaster.

Note that if a completed Manual Roast is saved from a Loring Roaster, it contains both a
Roast Profile and a Burner Recipe in one Profile file. If Burner Recipe data is present in the
Profile, it may also be ran as a Burner Recipe on a Loring Roaster. You may switch between the
two Edit modes on the same Profile, and the saved file will retain changes from both Edit
modes, but the two Edit modes do not interact with or affect one another.

Navigate to one of the topics below for more information on each Edit mode.

Roast Profile - Bean Temperature curves that can be used for either Manual or Profile roasting,
offering the most granular control and repeatability

Burner Recipe - A series of burner settings which activate after the Bean Temperature
surpasses its corresponding trigger point

Editing Products Files

The Edit mode for Products Files is a simple text box, with the Products in the form of a list.
Each line of text represents one Product.

For more detail, see Products File

Roast Profile

A Roast Profile is a Bean Temperature curve defined by specific Time and Temperature points
called Anchor Points. Editing a Roast Profile is accomplished by changing the placement and
number of Anchor Points.

Roast Profiles can be used in varying ways, which you may consider when designing, saving,
and naming the file. The Profile will be saved with the file type that corresponds to the Edit
mode toggled at the time of saving (either Roast Profile or Burner Recipe) and this file type
may influence its file location when uploaded to a Roaster. A Loring Roaster operating in
'Profile Roast' Mode will automatically follow the Bean Temperature curve using the PID
system. If operating in ‘Manual' mode, the Roaster will display the Bean Temperature Curve on
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the Roaster screen for reference, but will not automatically follow the curve. If Burner Recipe
data is present in the Profile, it can also be run as a Burner Recipe on a Loring Roaster. See
your Roaster Owner's Manual for more information.

Viewing a Roast Profile

To view a Profile, load it from the local hard disk or from the HMI screen into Roast Architect,
or create a new Profile. The screen should look like the one shown below. Opening a Profile
may show the Profile in a view-only mode. The Profile and its attributes cannot be edited in
this mode.
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The Profile in view-only mode

Change to Burner Recipe

The Editing Tools appear differently according to which Edit mode you are using- Roast
Profile or Burner Recipe. You may switch between the two Edit modes on the same Profile, and
the saved file will retain changes from both Edit modes. However, the two Edit modes do not
interact or affect one another. Note that if a completed Manual Roast is saved from a Loring
Roaster, it will contain both a Roast Profile and a Burner Recipe in one Profile file.

If the Profile is to be used as a Burner Recipe, click Change to Burner Recipe

%

Change to
Burner Recipe

The Roast Profile attributes will all be saved when you switch to editing as a Burner Recipe,
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and vice versa. Remember, the two Edit modes do not interact or affect one another.

The Profile will be saved with the file type that corresponds to the Edit mode toggled at the
time of saving (either Roast Profile or Burner Recipe) and this file type may influence its file
location when uploaded to a Roaster.

Roast Profile Editor Ribbon Bar Tools

Edit

Toggles between Edit mode and view-only mode.

Zoom Select

To zoom in on a specific time period, click the Zoom Select tool, then click and drag over the
desired section of the timeline.

Reset Zoom

Reset the time scale to the default period.

Rate of Rise Display

Roast Architect has the ability to show a Rate of Rise (RoR) curve alongside the bean
temperature curve. This is shown by checking the Show RoR check box.

* Show RoR

Rate of Rise
Ribbon Bar Rate of Rise Check-Box

Once selected, the Rate of Rise curve is shown in dark blue. A secondary axis on the right-hand
side of the graph will appear and shows the units of the Rate of Rise curve.
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Profile with Show Rate of Rise enabled

Undo/Redo

Use the Undo and Redo buttons to revert unsaved changes.

Snap EoR to Max Temperature

17

13

Change the End of Roast Attribute to the temperature of the Profile’s final point.

EoR Crop

Crops the Profile to the End of Roast temperature by adding a new anchor point at the EoR

point, followed by removing all succeeding anchor points.

Change to Burner Recipe

19

20

Change the Edit mode from Roast Profile to Burner Recipe. This does not remove any prior

unsaved changes made to the Profile.

Navigating the Graph

The following actions are available to modify the view of the graph.

Zoom In: While viewing the Profile, you can zoom in on the time span by hovering your

mouse over the graph and scrolling up with the mouse wheel. This will zoom in along the x-

axis (time), as demonstrated in the video below.

Zoom Out: To zoom out, scroll down with the mouse wheel until the full roast timeline is

visible again.

CUUTE Ry



Reset Zoom: To return the graph to its original zoom level, right-click anywhere on the graph
and select "Reset Zoom" from the menu that appears (you can also use the ribbon bar tool.)

This will return the x-axis to its full range.
Pan the Timeline: To move left or right across the zoomed-in roast timeline, use the scroll bar
located at the bottom of the graph. Click and drag the scroll bar to pan across the entire roast

span.
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e : 40
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20
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Zoom, Panning, and Reset Zoom

Highlighting
Hovering the mouse over the Rate of Rise curve will highlight the temperature point and show
it for a brief moment for review.

06:30, 14.5°F

Mouse Locations

Displays the location of the mouse on the graph. The coordinates will display the according
temperature and the rate of rise at the mouse location. This does NOT display the highlighted
temperature point on either the Bean Temperature or Rate-of-Rise curves.



Temp: 03:23, 239.5°F

RoR: 03:23, 38.3 A°F

Mouse Locations

Ribbon Bar Mouse locations display

Editing a Profile

Roast Architect

With Edit enabled, the Profile can be modified as desired. Roast Profile editing can be done
two ways: Graphical Editing, and editing the Attributes. Using the graph, drag the Anchor

Points to the desired position, or use the Attributes window to enter time and temperature
values for the Anchor Points.
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Roast Architect in Profile Editing mode

Anchor Points

An Anchor Point is a specific time and temperature point on the graph, and the number and
placement of these Anchor Points define the Roast Profile. Anchor points are displayed on the
graph as large points along the curve. They are also shown as numerical values in the Roast

Attributes window.
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An Anchor Point

Roast Attributes Window

The Roast Attributes window displays the parameters of the Roast Profile and the Anchor
Points, which in turn define the Roast Profile curve.



Roast Attributes

=Z  Time Temp.

+ Charge 00:00 278.0 °F
0019 184.1 °F

e 00:40  131.0°F

03:10 256.5 °F
orar 3949 °F
st Crack o9 426.9 °F

@5 "
g
i

12:14 4768 °F

End of Roast

EoR: 1200 + - 475.5 *F

Roast Settings
Batch: | 154.3 lbs

Initial Burner: | 100 %

Auto Cool
| ON
Before EoR: | 30 4°F |
Time: | 60 Sec

Start/Stop  11:59 12:59

The Roast Attributes Window

Roast Architect
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Anchor Points Table

+ Charge 00:00

TAP

e
@
o

The Anchor Points table allows for the direct editing of Anchor Points. The time and
temperature values can be input with a numerical keypad (MM:ss time formatting is required).
The time can be incremented and decremented from the table entry. Dragging the Anchor
Points using the graph will also modify the values in the Anchor Points table.

p3:03|+ = 23539°F

Editing and Anchor Point Table entry

Anchor Point Toolbar

From top to bottom, the toolbar functions:

Collapse Table: Hides the Anchor Point entries that are not named points. Also hides the Add
Point and Remove Point functions.

Add Point: Adds a new Anchor Point, after the currently selected point. Hidden if the Anchor
Point Table is Collapsed.

Remove Point: Removes the currently selected point in the Anchor Point Table. Hidden if the
Anchor Point Table is Collapsed.

Color Change, First Crack, and Second Crack: Adds the corresponding named Anchor Point.
To remove a named Anchor Point, first select the Anchor Point (or click into the value field),
then click on the icon to deselect it.

Named Anchor Points

There are several Anchor Points which are given specific names corresponding to common
terminology within the roasting process. These can help a roast designer parameterize the key
Anchor Points of a roast, and fine tune a final Profile around them. The named points are
displayed with individual icons and leaders in the Roast Attributes window, and some have
special indicators on the graph. Some points are optional, and can be added or removed from
the Anchor Points toolbar. More information aboutTAP and EoR can be found later in this
section.
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1. Charge 2. Turn-Around-Point (TAP) 3. Color Change 4. First Crack 5. Second Crack 6. End of Roast
Temperature (EoR)

Charge: The temperature at which the roast begins. Due to the nature of the roasting process,
the Bean Temperature will temporarily decrease from this temperature.

Turn Around Point (TAP): The time and temperature at which the Bean Temperature first
increases after the Charge point. Indicated by a red square and a pair of intersecting purple,
dashed lines.

Color Change: [Optional Point] The point at which coffee will be expected to first display
roasting color (also know as yellowing). Displayed by a red X and a pair of intersecting red,
dashed lines.

1st Crack & 2nd Crack: [Optional Points] The points at which coffee will be expected to
undergo the First Crack and Second Crack changes. Each is indicated by a red triangle or
square, and a pair of intersecting red, dashed lines.

End of Roast: The time and temperature at which the roast is expected to be completed.
Indicated by a pair of intersecting grey, dashed lines.

Turn Around Point (TAP)

The Turn Around Point is the time and temperature at which the Bean Temperature first
increases after the Charge point. The TAP on the graph is not a target temperature, and
represents an expectation, not a certainty. The actual Turn Around Point will be influenced
during a real roast by the Charge temperature, Initial Burner Setting, batch weight, and the
pre-heat state of the Roaster.



The Turn Around Point is not optional. It can be adjusted like other Anchor Points with either
the Anchor Point Table, or by dragging it on the chart area. The TAP can additionally be
adjusted by holding Left Ctl + Right Mouse to drag the TAP Leaders. Note that dragging the
TAP leaders will scale the entire Profile curve.
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Adjusting the Turn Around Point

End of Roast (EOR)

The End of Roast Parameter for a Profile is the temperature at which the roast is expected to
be completed, and at which a Loring Roaster will complete an automated roast ( Refer to the
Loring Roaster Operator Manual).

The End of Roast temperature is not optional. It can be changed by entering a time or
temperature value in the EoR section of the Roast Attributes window. When one parameter is
entered, the other parameter will be automatically calculated according to the Profile. The
EoR point can additionally be changed by holding either of the leaders with the mouse and
dragging the leaders to the desired point of the Bean Temperature Profile on the chart.

The End of Roast time or temperature cannot be set greater than the time or temperature of
the last Anchor Point on the Profile.

NOTE: If the EoR temperature exceeds the highest temperature of the Profile, a Loring
Roaster will attempt to reach the EoR temperature very quickly. This may significantly



increase the Burner Set point, and the EoR Time may be extended.
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Editing the End of Roast with leaders

Roast Settings

Batch: The designed weight of the batch for this Profile. A Loring Roaster will use this weight
to automatically adjust the Profile for use on smaller or larger batch sizes.

Initial Burner Setting: The Initial Burner Setting that will be used by a Loring Roaster after the
completion of Charge, until after the TAP, at which point the Roaster will follow the Roast
Profile. The Initial Burner Setting is indicated on the graph with an orange shaded area.
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Auto Cool

When enabled, the Auto Air Cool feature is triggered at a specified number of degrees before

the EoR temperature. Auto Air Cool opens the Purge Gate at the back of the Roaster, and

ramps the Burner to 100%. This is a smoke abatement feature that reduces the amount of

Cooler Tray smoke by incinerating it before the roast is finished.

¢ When enabled, the Auto Air Cool feature will no longer complete the roast at the EoR
temperature, but will complete the roast when the Air Cool Time has elapsed

e When enabled, the graph will display the designed Auto air cool period as a purple
rectangle

Air Cool: (11:27, 416.0 °F) EoR at 12:27

The bar indicates the designed Auto Air Cool period on the Roast Chart

OFF/ON: Enable or Disable the Auto Cool function default setting for this Roast

Before EoR: Specify the amount of degrees before the End of Roast Temperature which Auto
Air Cool will begin

Time: Length of the Auto Air Cool procedure

Start/Stop: The Expected times at which the Auto Air Cool procedure will begin and
complete. The actual Start and Stop times may vary
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Profile Scaling

The Entire Profile curve can be scaled by either Time or Temperature by holding Left Ctl and
using the Right Mouse button to drag the EoR Leaders (Left Ctl + Right Mouse.)
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Scaling the Profile curve using Ctl + Right Mouse Button
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Burner Recipe

Burner Recipe

Burner Recipes are automated burner schedules triggered by bean temperature. Each
specified burner setting activates after the bean temperature surpasses its corresponding
trigger point. A Burner Recipe includes two sequences: temperature triggers (yellow bars) and
burner settings (blue bars). Every burner setting must have a matching temperature trigger for
proper operation.

As the roast progresses, each trigger point activates its burner setting in order, continuing until
burner value reaches zero. From there, the system maintains operation until the End of Roast
temperature is reached.

A Burner Recipe is generated by a Loring Roaster when operating in Manual operation mode,
and each burner setting modification during a roast will be saved with its corresponding
trigger temperature. When a Burner Recipe is saved from a manual roast, the file also contains
a Roast Profile recorded from the bean temperatures during the roast. Modifying the Burner
Recipe does not alter its associated Roast Profile, and vice versa.

The Profile will be saved with the file type that corresponds to the Edit mode toggled at the
time of saving (either Roast Profile or Burner Recipe) and this file type may influence its file
location when uploaded to a Roaster.
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Viewing a Burner Recipe

To view a Profile, load it from the local hard disk or from the HMI screen into Roast Architect,
or create a new Profile. The screen should look like the one shown below. Opening a Profile
may show the Profile editor in a view-only mode. The Profile and its attributes cannot be
edited in this mode. Click Edit to enable editing.

Recipe Edit

New Burner Recipe with Editing enabled

Roast Attributes

For information about the Roast Attributes, see Attributes.

The EoR point, Roast Settings (Batch and Initial Burner Setting), and Auto Cool settings can be
edited from the Burner Recipe editing page.

The other attributes (expected TAP, color change, and 1st and 2nd crack) can be modified by

clicking Change to Profile Recipe.

Clear Burner Data
Deletes all Burner Recipe Trigger Points

Change to Roast Profile
If the roast is to be designed as a Roast Profile, click Change to Profile Recipe.




Change to
Profile Recipe

The Burner Recipe attributes and Trigger Points will all be saved during a conversion to editing
as a Roast Profile.

The Profile will be saved with the file type that corresponds to the Edit mode toggled at the
time of saving (either Roast Profile or Burner Recipe) and this file type may influence its file
location when uploaded to a Roaster.



Products File

Products File

Products files are lists that will populate the Product field drop-down on the Roaster. The
Product specified at the start of a roast will display on the Roaster screen during the roast, and
be included in the Post-Roast Notes.

Note also that the Roaster will only recognize Products Files named RoasterProducts.
Therefore, only one Products file can be used on the Roaster at one time. Products files with
other names will not open or populate the drop-down menus on the Roaster screen.

Creating or Opening a Products File
To create a new Products file, see the Quick Start Guide toCreate a New Products File

To open a Products file from the local computer, see the Quick Start Guide to Open a Local
File

To open a Products file directly from the Roaster, see the Quick Start Guide toModify an
Existing File on a Roaster

Editing a Products File

The Edit mode for Products Files is a simple text box, with the Products in the form of a list.
Each line of text represents one Product.

To upload a Products File onto a Loring Roaster, see Upload File to a Roaster
Navigator Panel

The Navigator panel in Roast Architect offers access to all Loring Roasters on your network
through Ethernet communications for Loring Roaster systems. Navigator lists the Roaster
machines recognized by Roast Architect.
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Navigator Icons

The icons you will see in the Navigator panel are as follows:

D - All Opened Files Tree - This tree holds all Roast Architect recognized files.

E - an Loring Devices Tree - This tree holds all Roast Architect recognized devices (PLCs,
HMI, etc.).

Recognized Device Icons

i - 2.X based PLC - This identifies an H2/BRX Processor PLC
B - 2.X based HMI - This identifies a Beijer iX Pro series HMI.

- 1.X based PLC - This identifies a DL205 series PLC.
- 1.X based HMI - This identifies a Beijer T100 series HMI.

.— UNKNOWN Device - This identifies a device that shows a connection to the LAN but is
not recognized as a Loring Device.

Device Group Icons

. - 2.X Recognized Loring Roaster Group - When a 2.X PLC B and a 2.X HMI Bl are
grouped together, they are recognized as a 2.X based Roaster. Roast Architect has functions
that make use of this association. The flame icon will appear if the group contains a PLC
device along with a HMI device.

& - Device Group - General device group. These groups are available to associate Loring



recognized devices.

File Icons

=2 - Files folder - This icon represents a folder containing files associated with the HMI
screen.
[ - Roast Architect File - This shows a recognized Roast Architect file.

The Navigator Tool Bar

The Navigator Tool Bar assists in adding and organizing Loring Roaster devices, such as Loring
PLCs and HMI screens.

£ Wy £

Manually Adding A Device
You can manually add PLC and Roaster devices by entering the IP address of the Roaster. From

the Navigator tool bar, find the button with the icon . Clicking this button will prompt you
to enter a valid IP address for the PLC or HMI. A small prompt box will appear and ask you for
the valid IP address of the device.

IP Address: 192.168.1.199

Cancel

Upon entering a valid IP address, Roast Architect will automatically try to identify the device
and display the accurate information corresponding to the entered device. The identified
devices will be listed in the main tree within the device section of the Navigator panel.

i By

~ = Loring Devices

~ HML HMI 09999 192, 168, 10,190

| —

Grouping Devices

Connected devices can be grouped and organized into device groups for convenient
organization. A device group allows users to associate different devices into a single common
group. For example, a PLC and HMI can be combined to represent a Roaster. To create a
group, locate the button with the icon B in the Navigator toolbar. Clicking this button will
create a group node in the list. Double-click on the group node to rename it. Enter the desired



name, then press Enter to change the group's name, as shown in the images below.

w =" Loring Devices

By 570 Morth End

w AT HMI 09999 192,168, 10,190

Next Drag and Drop any of the listed devices into the Device Group folder.

The Once organized the system should look similar to the following picture.

Navigator 7
S ®B Gy g & ~
s =" Loring Devices

> L_‘,‘-EFiIes

Notice how the folder icon change to a Y icon. This indicates that the folder contains a PLC

and a Screen which when combined designates a v2 S-Series Roaster. The v1 series does not

change its icon and retains the default Device Group icon ™l

Automatic Loring Device Detection

Roast Architect can auto-detect all Loring Ethernet devices that are present, and turned on for

a given LAN. To perform this feature, the PC that must be on the same LAN as the Loring
equipment. You may need to turn off your firewall for this feature to work correctly. To start
the auto-detect process click the scan and refresh button in the navigator tool bar. This will
show a wait-cursor while Roast Architect scans the network for Loring Ethernet Devices. After a
short moment the system should return all recognized Loring Ethernet devices detected on the
LAN.

W Scan E

Scan and R-efresh Button

Removing a Device from the Device Tree

To remove a device from the Device Tree list, select the device to be removed, right click and
select Remove from the context menu.
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Remove Device

The device will then be removed from the list.

Deleting a Group
To delete a group from the Device Tree list select the Device Group folder and right click on it.
A context menu will appear. Select Remove. The devices contained will NOT be deleted

w ‘o=’ Loring Devices

Collapse Lo

Full Collapse

Rename Group

Delete Group

Navigator Functions

Open a File On the Screen
Files can be opened by selecting the file of interest, right clicking the file, and selecting Open
from options menu.
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Close an Opened File

Files that are listed under the Opened Files tree list can be closed by selecting the file of
interest, right clicking the file, and selecting Close from the context menu.

If the file was originally on the screen, the updated file will automatically be pushed back to
the screen.

Browse to a Remote File

Windows Explorer will open with the correct directory being selected and the file of interest
selected as the image below (image shows a remote HMI file.).
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Uploading a File to the Screen

Files get uploaded to the HMI screen by performing a right click on the HMI Files folder to
show the folder options menu. Select Upload Files which will open a Open File dialog form.

3§ 570 NorthEnd
- 192.168.50.190

Fefresh

| UploadFiles

Select a file to upload to the screen. The files will automatically be sorted by extension type to
their correct folders. Profiles will be sorted into their correct sub-folders based on their type
(Roast Profile or Burner Recipe).

ew tolder == - i
~

rsor A Mame Date ™
% BASELIME_OO1.Ircp a/as2

rer % BASELIME_00Z.Ircp B8
8 BASELIME_003.Ircp 8/82
§ BASELIME_0Qd.|rcp a/82
& BASELIME_005.lrcp 8/82
% BASELIME_0DG.Ircp a/as2

awir " BASELINE 007Irep e Mo preview available.
% BASELIME_0DB.Ircp a/as2
8 BASELIME_00.lrcp B/8/2
8 BASELIME_OTQulrcp a/82
8 BASELIME_O11.lrcp a/82
& BMBGI_RECIPE.Ircp 8/82
% EMPTY_BASELIME.Ircp a/as2
% SHARK FIM.Ircp a/as2
% SIMPLE CURWE.Ircp B/af2 v

v < >
File name: | BASELIME_Q0S.Ircp v| Roast Architect Files (. rcp; *

After the file uploads, the file tree will refresh, showing the file in its correct location.
WARNING - IF A FILE ON THE SCREEN HAS THE SAME NAME AS A FILE BEING UPLOADED,
THE FILE ON THE SCREEN WILL BE OVERWRITTEN. THIS CANNOT BE UNDONE.

[Je iy s N [H B ou [ W)

=-B3 Files
—D RECIPE
—D BASELIME

Deleting a File from the Screen

To delete files off a screen, select the file of interest, right click on the file, and select the menu
option Delete. The file tree will refresh and show that the file was deleted from the screen.
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Downloading a File from the Screen

Files located on the screen can be downloaded by selecting the file of interest, then right
clicking the file and selecting the Download menu option.

E- % 515 SouthEnd

-G 192.168.50.204
=P Files
=-Fq RECIPE
=B BASELINE
~-[E] 570T 5TK 20 PER AC Ircp
--[2] S70T 5TK 100 PER AC Ircp
..... |§| 5
..-[E] §35T STK 20 pen
----- 3 BURMER Browse
----- F1 ROASTP Tt
=-B7 PRODUCTS
..[2] RoasterProdud Download
----- P SETUPDIR
..M SOFFICE 167 1R% RN 707

A file Save As dialog will appear, allowing you to pick the file name and location to download
to.
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§ Save As

« v P R X e ¢ Ll ek w | @ Search Scratch

Organize » New folder

E This PC 2 Name Date modified Type Size

) 3D Objects
[ Desktop

@ Documents
; Downloads
Jl Music

&= Pictures

m Videos

i Local Disk (C:)
- .
B MCEC N BT
= .

i N .

A
B MRS N N

WA IR Y

8=

File name: | 535T 5TK 100 PER AC.Ircp

Save as type: | Roast Architect Files (*.Ircp; *.Iprd; *.Icfg)

» Hide Folders

Cancel

Navigator Double Click Functions

Open Files

Files can be opened by navigating to the file of interest and double clicking them.

- % S70MarthEnd

= 192.168.50.190

. =-P3 Files
=-B7 RECIPE

E1-F7 BASELIMNE

R SELIME 005 rep

B3 BURNER

Double clicking will open the file in Roast Architect.
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FAQ and Troubleshooting

e Installing Roast Architect on a Mac System using Parallels Virtualization Software
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RA Install for Mac™

Using Roast Architect on G Mac™ Computers - Installing Parallels

Although Windows is a requirement to install Roast Architect there is a way for Mac™ users to
install the program on their computer via a Mac™ compatible program called Parallels which
is available on the App Store. Currently Parallels requires an annual fee of $99 per year, though
they currently permit a 2-week trial. Parallels is a third-party and not a subsidiary of Loring.
Hardware and operating systems must meet the following requirements for a Mac™ to be
eligible for Parallels installation:

e Processor: Any Apple silicon chip (M1, M1 Pro, M1 Max, M1 Ultra, M2, M2 Pro, M2 Max,
M2 Ultra, M3, M3 Pro, M3 Max, M4, M4 Pro, M4 Max).

e Memory: At least 4 GB of RAM.

e Storage: 600 MB for Parallels Desktop application installation, plus additional disk
space for the guest operating system. At least 16 GB is required to install Windows OS.

e Graphics: Any Apple silicon chip.

e Operating System: macOS Sequoia 15.0 or newer, macOS Sonoma 14.0 or newer,
macOS Ventura 13.4 or newer, macOS Monterey 12.6 or newer, macOS Big Sur 11.7 or
newer, macOS Catalina 10.15.7 or newer, macOS Mojave 10.14.6 or newer.

You may install Parallels using the following steps:

1. Navigate to the App Store on the computer that you would like to install Parallels and
Roast Architect on.

2. Within the App Store you will need to search for the app shown below and then select
the Get button to the right of it.

Mac Apps  iPhone & iPad Apps

) Parallels Desktop
ql Run apps for Windows Get
* %k ok kt B4K .

T —

§ =

3. The App Store may request that you verify your apple id and apple password before
proceeding to download.

4. Once the app has finished downloading from the App Store the button on its entry will
switch from ‘Get’ to ‘Open.’ Clicking this button will launch setup for the app.

5. The app will promptly begin installing Windows 11.
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Download and Install
: Windows 11
Installation will start automatically. While you wait,

explore what you can accomplish with Parallels Desktop
for Mac.

-
249.4 MB of 4 GB (72.4 MB/sec) - less than a minute remaining

Cancel Pause

6. Once Windows 11 has installed completely you can proceed to register an account
with Parallels as shown below.

[ N Parallels Deskiop

Sign In to Parallels Account

O | am a new user | have a password Other sign-in options:
Email: & Sign in with Apple
Name: || o
€ Sign in with Facebook

Password:
& Sign in with Google

Confirm password:

Create Account...

7. Once you have finished providing information regarding your account you can select
‘Create Account’ and you will receive the following options.
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® Parallels Desktop parallels@loring.com +

Run Windows, Linux, and others

Run Windows and its apps, including many games and CAD programs.

Try it for free for 14 days, then $99.99fyear, cancel at any time.
Subscription includes product updates and 24/7 Premium Support.

? Restore Purchases | Have Subseription m

8. If you are subscribing for the first time you will need to select the subscribe option
listed at the bottom of the window. This will use the card that you already have on file
for your Apple ID, but it will provide you with a two-week free trial. We would
recommend that you note the date that this trial expires should you decide to cancel
the membership before the trial period ends.

9. Once the subscription is enabled Parallels should begin installing the Windows 11
operating system as shown below.

® Installation Assistant == B

Installing Windows 11

everal times. This might

Installing Windows 11

(¥) This process usually takes 5 to 15 minutes te complete.

&, Please do not interrupt it.

While you wait, explore what you can do with Parallels Desktop.

10. Once you receive this message inside of Parallels that is a sign that you have
successfully installed Windows within Parallels
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8 Guest) [ || instaliation Firished x | -~ a8 x
G ] https://www.parallels.com/products/desktop/welcome-win/ AN D3 [D {% %
a
| ' PEI‘BIIEIS' Products Solutions Partners Resources Support @ Signin

Windows 11 Installed
Successfully
Use it just like you would on a PC.*

Next step: activate your copy of
Windows 11.

* Various Windows applications and features may not
work in Windows 11 on Apple M-series Mac @
computers. Learn more

11. To have full Windows functionality you will need to also purchase a Windows 11 Pro
license.

12. To purchase this license you can proceed to the settings page within the Parallels
Windows installation. It should provide you with a prompt letting you know that your
instance of Windows isn't active and give you the option to activate.

€ Settings

[ ] gregschiller System

@  Local Account

GREGSCHILLE30F2 mm Microsoft 365 Windows Update
Find a setting a Parallels ARM Virtual Machine BE o benefits @ = Attentlon needed
Rename

| B System
Bluetooth & devices R o B R
© Windows isn't activated. Activate now
@ Network & internet
o Display
# Personalization 8 onitors brightness, night light, display profile 2
[ S
Sound
A D) E ourn N S
@ Accounts Volume levels, output, input, sound devices
3 Time & language L
Q Notifications 5
@ Gami Alerts from apps and system, do not disturb
aming
l" Accessibility = [
(Q,‘ -ocus 5

Reduce distractions
J Privacy & security

@ Windows Update o Power R

Screen and sleep, power mode, energy saver

13. Once you select that option it will take you to a Microsoft store page giving you the
option to purchase a Windows 11 Pro license. Select the blue button labeled ‘Get for
$199.00.
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@  WMicrosoft Store Search apps, games, movies, and more

|
&8
Apps
.
a Windows 10/11 Pro
aming
(i With Windows 10/11 Pro you get enhanced features to help you easily connect to company networks, access one
intertainment PC from another, encrypt your data, and more. For advanced technical and security features, go Pro.
<C>¢ This is not an upgrade from Windows 10 to Windows 11. To learn more about upgrading to Windows 11, see
e aka.ms/upgradetowindows1l
Get for $199.00
Upgrade to Workstation
| have a Windows 10/11 Pro product key
Get Windows 10/11 Pro with a genuine license for this PC.
&
Whats New
(0
Downloads
00 2
Need more info?

14. This will open a window prompting you to sign in to a personal Microsoft account and

then provide payment information.
15. Once the purchase is complete you will have successfully activated your Windows

license, and this will be displayed in your System menu.



System > Activation

== Windows 11 Pro

[E_'! Activation state
p Change product key

Fq Get help

& Give feedback

Roast Architect
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